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МЕТОДЫ СОЗДАНИЯ 3D-МОДЕЛЕЙ КОРПУСНЫХ ДЕТАЛЕЙ 
В СИСТЕМЕ PRO/ENGINEER  

Описываются методы построения пространственных геометрических моделей корпусных 
деталей в системе Pro/Engineer, приводятся приемы использования инструментария системы на ос-
нове операций, для выполнения которых требуется уже некоторый опыт работы в системе, предла-
гается апробированный алгоритм проектирования модели детали «корпус» турбокомпрессора. 

Введение  

В периодических изданиях информация о системах компьютерного проектирования (да-
лее CAD-системы) состоит в перечислении их общих функций. Описание опыта внедрения 
CAD-системы в процесс проектирования и производства ограничивается перечнем используе-
мых при работе программных модулей. В инструкциях по эксплуатации CAD-системы отсутст-
вуют методы создания 3D-моделей корпусных деталей, что вызывает затруднения по ее приме-
нению на начальном этапе. Поэтому полезно было бы приводить методы использования инст-
рументария CAD-системы при решении конкретных проектных задач [1–3].  

В соответствии с толковым словарем русского языка С.И. Ожегова и Н.Ю. Шведовой метод 
следует понимать как «способ теоретического исследования или практического осуществления че-
го-нибудь» или «способ действовать, поступать каким-нибудь образом». Если рассматривать такую 
область, как проектирование, то конструктор при разработке проекта применяет целую систему 
методов, направленных на переработку представления об объекте проектирования в материалы 
проекта. Это методы анализа, синтеза, алгоритмизации и моделирования. Первые два метода охва-
тывают традиционные приемы конструирования: блочно-иерархическое, агрегатно-модульное про-
ектирование, восходящее и нисходящее проектирование и пр. Методы алгоритмизации и геометри-
ческого моделирования используются при решении проектных задач с помощью компьютера. Ка-
чественным содержанием метода моделирования применительно к компьютерному автоматизиро-
ванному проектированию является система приемов, способов, операций по применению инстру-
ментария CAD-системы при проектировании заданного класса конструкций (синтез конструктив-
ных и технологических элементов). Алгоритм моделирования в данном случае задает конкретную 
последовательность, в которой реализуется геометрическая форма объекта проектирования или, 
иначе, сценарий решения проектной задачи (синтез геометрических элементов). Алгоритм является 
частным случаем и примером использования метода моделирования, так как создается для каждой 
конкретной детали на основе разработанного метода проектирования класса конструкций. Отсутст-
вие метода моделирования ставит под сомнение адекватность модели реальному объекту.  

На основании сказанного в данной статье описывается метод построения 3D-моделей 
корпусных деталей в системе геометрического моделирования Pro/ENGINEER, приводятся 
приемы использования инструментария системы на основе операций, для выполнения которых 
требуется уже некоторый опыт работы в системе, предлагается апробированный алгоритм про-
ектирования детали «корпус» турбокомпрессора. 

1. Особенности и средства системы моделирования 

Геометрическое ядро Pro/Engineer использует технологию Proven Technology, основан-
ную на граничных представлениях и предъявляющую жесткое требование к проектируемой 
геометрии: пространственное положение всех точек, образующих и элементов должно быть 
определено однозначно. Соблюдение этого требования вызывает некоторые трудности при мо-
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делировании, но в итоге предотвращаются возможные ошибки со стороны пользователя и со-
храняется целостность модели (отсутствуют несшитые поверхности). 

Параметры элементов моделируемого в системе Pro/Engineer объекта не обязательно за-
даются относительно какой-либо системы координат. Система координат может даже отсутст-
вовать. Принцип параметризации основан в первую очередь на задании между конструктивны-
ми элементами объекта различного рода геометрических связей: параллельности, перпендику-
лярности, соприкосновения. 

Метод проектирования в системе основан на управлении параметризованными конструк-
тивными элементами: фасками, ребрами, отверстиями и др. Кроме того, при создании геомет-
рических элементов используется эскизная технология, когда форму добавляемого или вычи-
таемого материала задает плоский контур – эскиз, являющийся параметризованным объектом. 
Следует отметить удобство работы с эскизом в системе Pro/ENGINEER. Эскиз динамически 
перерисовывается при изменении какого-либо параметра, что позволяет отследить «мертвые 
точки» (дальнейшее изменение параметра при заданных ограничениях невозможно) и зоны ис-
кажения эскиза (при существующих геометрических и параметрических связях система реали-
зует неподходящий вариант эскиза). Благодаря этому возможно легкое и быстрое построение 
сложных параметризованных эскизов. 

2. Подходы к созданию 3D-модели корпусной детали 

Перед созданием трехмерной параметрической модели следует продумать оптимальную 
последовательность построения модели из конструктивных элементов и характер геометриче-
ских связей между ними. Для этого целесообразно выполнить эскиз будущего изделия (эскиз-
ный или технический проект). Практика показала, что если последовательность построения мо-
дели согласуется с технологией изготовления изделия, то при этом формируется корректная 
последовательность формообразующих операций.  

Моделировщик может столкнуться со следующей ситуацией. При построении трехмер-
ной модели следует стремиться к уменьшению количества формообразующих операций. Это 
может ускорить процесс моделирования. Малое количество формообразующих операций также 
способствует более корректному восприятию 3D-модели аналитическими и расчетными систе-
мами за счет уменьшения количества стыкуемых поверхностей, но при этом уменьшаются диа-
пазон и гибкость модификации модели для получения других вариантов конструкции. Поэтому 
всегда следует учитывать такие факторы, как  назначение модели (конструкторская, расчетно-
аналитическая, технологическая), необходимость модификации в будущем и др. 

Еще одним моментом является то, что элементы модели оказывается удобнее строить по 
одним параметрам, которые затем благодаря ассоциативным связям автоматически отобража-
ются в ассоциативном электронном чертеже, в то время как технологу предпочтительнее ви-
деть в бумажном чертеже совсем другие параметры, обеспечивающие установку, обработку и 
контроль детали. В разд. 3 приведен способ задания параметров воздуховода в 3D-модели в от-
личие от способа его образмеривания на чертеже. После этого бывает трудно проставить на 
ассоциативном чертеже параметры, необходимые технологу. 

Проектирование на плоскости отличается от проектирования конструкции в пространст-
ве. Проектирование детали в пространстве идет сверху вниз от задания примерной формы де-
тали к уточнению и разработке каждого конструктивного элемента. При проектировании дета-
ли на плоскости конструктор вычерчивает последовательно каждый конструктивный элемент 
исходя из его функционального назначения и последовательно приходит к форме всей детали. 
Математически точная 3D-модель однозначно задает геометрическую форму детали, оказыва-
ется при этом согласованной с ее представлением на плоскости и функционированием в соста-
ве сборочной единицы. При ручном проектировании на плоскости такая увязка отсутствует и 
имеет место условное представление детали в виде проекций. 

С учетом этих подходов и особенностей работы в системе Pro/ENGINEER предлагается 
следующая последовательность моделирования корпусных деталей: 

– строится базовое тело; 
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– по отношению к базовому телу применяются операции формообразования на основе 

плоских контуров; 
– строятся формообразующие тела; 
– выполняются логические операции формообразования между базовым телом и формо-

образующими телами; 
– моделируются бобышки, буртики; 
– добавляются приливы, выступы; 
– строятся вырезы, отверстия; 
– выполняются операции копирования, размножения; 
– моделируются уклоны; 
– задаются сопряжения по радиусу. 
Этот порядок действий был определен после нескольких неудачных итераций по назначе-

нию базового тела и создания последующих формообразующих элементов для детали «корпус». 
Базовое тело служит основой для дальнейшего моделирования. Все последующие элементы гео-
метрической формы, логически развивающие модель, опираются на базовый. Отсюда исходит 
важное значение правильного определения базового тела, так как иначе формируется некоррект-
ная иерархия конструктивных элементов, впоследствии вызывающая определенные трудности 
при модификации модели. В качестве базового следует принимать тело, которое отражает наибо-
лее общие черты формы моделируемого изделия или имеет наибольшее число геометрических 
связей с другими формообразующими элементами, т. е. находится на верхнем уровне иерархии. 

3. Алгоритм создания 3D-модели корпусной детали 

Деталь «корпус» турбокомпрессора (рис. 1) отливается из алюминия. Геометрическую 
форму невозможно обобщить каким-то одним конструктивным элементом. Поэтому деталь 
мысленно разбиваем на конструктивные элементы, называемые условно воздуховод, раструб, 
горловина и буртик. Геометрия поверхности воздуховода образуется при  вращении вокруг оси 
сечения в форме кругового полукольца, которое изменяет свои размеры, сохраняя при этом 
форму, а затем плавно переходит в раструб. К воздуховоду с внешней стороны примыкает бур-
тик. В центре детали размещается горловина, имеющая форму втулки. При формообразовании 
детали используются две полуформы для оформления наружной и внутренней поверхности и 
стрежень – для оформления внутренней поверхности раструба.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1. 3D-модель детали «корпус» 

В соответствии с разработанными подходами к моделированию корпусных деталей соз-
дан и опробован алгоритм моделирования детали «корпус» (рис. 2).  

В каждом вновь создаваемом файле модели *prt автоматически генерируются базовые 
элементы: три взаимно перпендикулярные базовые плоскости и система координат, которые 
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служат для упорядочивания положения базового тела в пространстве модели. Последующие 
формообразующие элементы могут быть определены относительно базовых плоскостей, плос-
костей базового тела или дополнительно построенных плоскостей. 
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Рис. 2. Блок-схема алгоритма создания 3D-модели детали «корпус» 

Для рассматриваемой детали «корпус» в качестве базового тела целесообразно принять 
воздуховод. Воздуховод является наиболее сложным для моделирования геометрическим эле-
ментом в детали. Для его построения целесообразно применить метод соединения поворачи-
ваемых сечений. В этом случае геометрия воздуховода задается множеством поперечных сече-
ний. Данный метод имеет ряд преимуществ: 

– каждое сечение базового тела рисуется в отдельном окне-эскизнике; 
– можно использовать ранее созданные пользователем эскизы в качестве сечений; 
– легко проводить корректировку, так как можно открыть в отдельном окне только опре-

деленное сечение и изменить его параметры; 
– данный метод однозначно задает геометрию и исключает возникновение ошибок. 
Чтобы реализовать метод соединения поворачиваемых сечений, необходимо выполнить 

последовательность команд и действий: 
– Feature > Create > Solid > Protrusion > Solid Opts (Blend + Solid + Done); 
– задать опции элемента соединения Rotational + Regular Sec + Sketch Sec + Done; 
– определить атрибуты Smooth + Open + Done; 
– выбрать базовую плоскость, на которой будет создан эскиз первого сечения; 
– задать направление добавления сечений; 
– выбрать ссылку для эскиза по умолчанию Default; 
– для активизации команды определения системы координат эскиза выбрать из падающе-

го меню Sketch > Coordinate System; 
– совместить систему координат эскиза с базовой системой координат; 
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– создать и образмерить эскиз сечения, задать его положение относительно системы ко-

ординат (рис. 3, а);  
– сохранить эскиз сечения File > Save a Copy;  
– закончить работу в эскизнике c данным сечением; 
– ввести угол поворота для следующего сечения; 
– открыть сохраненный ранее (двумя шагами выше) эскиз сечения Sketch > Data from 

File, который будет задавать форму второго сечения; 
– задать параметры эскиза второго сечения и положение относительно системы координат; 
– закончить работу в эскизнике cо вторым сечением; 
– ответить на запрос системы: Continue to next section? 
     Yes – переход к определению следующего сечения; 
     No – если все сечения определены; 
– подтвердить результат операции (рис. 3, б) в окне Protrusion: Blend, Rotational. 
 
 
 
 
 
 
 
 
 
 
 
 
 

а) б) 

Рис. 3. Пример создания элемента соединения проворачиваемых сечений: 
а) эскиз первого сечения; б) модель детали на этапе построения воздуховода 

Следует обратить внимание на то, что количество объектов построения (линий, дуг) в 
каждом из сечений должно быть равным. Если есть необходимость обойти это ограничение, 
можно использовать сплайн-линию, которая, хотя и будет построена по нескольким точкам, 
воспримется как одна линия. 

Необходимо следить за тем, чтобы положение начальной точки рисования каждого из эс-
кизов не изменялось. Центр систем координат должен находиться в одной и той же точке. Сис-
тема будет располагать сечения путем вращения каждого из них вокруг оси системы координат 
предыдущего сечения. 

Удобно задавать сечения по следующим параметрам (отмечены рамкой на рис. 3, а): ра-
диус дуги сечения, высота центра дуги над плоскостью, расстояние до оси вращения (горизон-
тальный размер остается постоянным). Такая схема позволила параметризовать воздуховод без 
расчета центральной линии, т. е. спиральной линии, которая проходила бы через центры дуг 
сечений, как это было задано на чертеже. Попытка воссоздания в электронной модели спираль-
ной линии подтвердила некорректность ее задания на чертеже с помощью радиусов дуг, кото-
рые ее составляют.  

На следующем этапе создания модели строим раструб (рис. 4). Перед построением сле-
дует создать плоскость эскиза, перпендикулярную к первому сечению воздуховода и проходя-
щую через центр его дуги.  

Для построения элемента вращения необходимо выполнить последовательность команд и 
действий: 

– Part > Feature > Create > Solid > Protrusion > Solid Opts (Revolve + Solid) > Done; 
– задать атрибуты One Side>Done; 
– выбрать плоскость эскиза; 
– подтвердить направление вращения; 
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– выбрать ссылку для эскиза по умолчанию Default. 
– перед рисованием эскиза следует задать ось вращения. Эскиз должен находиться только 

с одной стороны от оси вращения; 
– нарисовать эскиз и образмерить его (рис. 4, а); 
– закончить работу в эскизнике; 
– задать угол поворота сечения 360; 
– подтвердить результат операции в окне Protrusion: Revolve (рис. 4, б). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

а) б) 

Рис. 4. Построение раструба: а) эскиз; б) модель раструба 

Буртик строим также методом построения элемента вращения (рис. 5). К существующей 
геометрии присоединяется горловина методом построения элемента вращения (рис. 6). 

На следующем этапе строится модель бобышки. Для построения всех бобышек рацио-
нально будет использовать операцию размножения по круговому массиву. Практика показала, 
что при построении кругового массива целесообразно в качестве эскиза размножаемого эле-
мента использовать наиболее простую геометрию, чтобы предотвратить возможные некоррект-
ные ситуации. Так, при моделировании детали «корпус» в качестве эскиза бобышки использо-
валась окружность (рис. 7, а) как наиболее просто определяемая геометрическая форма.  

Не следует использовать какие-либо геометрические привязки эскиза к уже существую-
щим элементам модели, так как это может привести к его искажению при изменении угла вра-
щения эскиза вокруг оси массива. Если это произойдет, то операция размножения по круговому 
массиву не выполнится.  

В данном случае центр окружности, определяющей бобышку, лежит на предварительно 
построенной оси, которая будет вращаться вокруг центра вращения при выполнении размно-
жения. Необходимо задать начальный угол между этой осью и базовой плоскостью, диаметр 
окружности, расстояние от центра окружности до центра вращения. Отсутствие искажения эс-
киза проверяется путем динамического изменения углового параметра. 

Для создания бобышки операцией выдавливания эскиза на глубину необходимо выпол-
нить следующую последовательность команд и действий: 

– Part > Feature > Create > Solid > Protrusion > Solid Opts (Extrude + Solid) > Done; 
– задать атрибуты One Side > Done; 
– выбрать плоскость эскиза (плоскость основания); 
– подтвердить направление выдавливания (в тело основания (рис. 7, б)); 
– выбрать ссылку для эскиза по умолчанию Default; 
– нарисовать эскиз и образмерить его; 
– закончить работу в эскизнике; 
– задать глубину выдавливания Blind; 
– подтвердить результат операции в окне Protrusion: Extrude. 
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а) б) 

Рис. 5. Построение буртика: а) эскиз; б) модель с буртиком 

 

 

 

 

 

 

 

 

а) б) 

Рис. 6. Построение горловины: а) эскиз; б) конструктивный элемент 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

а) б) 

Рис. 7. Построение бобышки: а) эскиз; б) результат построения 
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Операция размножения Pattern создает в общей модели копии бобышки, располагаемые 

по круговому массиву. Для ее реализации следует выполнить следующую последовательность 
команд и действий: 

– Part > Feature > Pattern;  
– выбрать элемент бобышки (рис. 8, а); 
– задать опцию размножения General; 
– выбрать контрольный размер размножения – угол между базовой плоскостью и осью, 

на которой лежит эскиз бобышки, щелкнуть Done; 
– ввести количество элементов размножения, включая исходный, указать Done; 
– определить приращение (шаг) этого углового размера. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

а) б) 

Рис. 8. Операция построения массива бобышек:  
а) определение параметров размножения; б) результат построения 

Построение отверстий, задание уклонов и скруглений не вызывает затруднений.  
Следует отметить, что при построении сопряжения между двумя поверхностями пользо-

ватель может столкнуться с конфликтной ситуацией, когда задан настолько большой радиус 
скругления, что сопряжение захватывает соседнюю (третью) поверхность (рис. 9). 
Геометрический аппарат системы не может реализовать такую задачу. Проблема решается 
путем задания меньшего радиуса сопряжения. 

 
 
 
 
 
 
 
 
 
 
 
 

Рис. 9. Задание скругления между элементами 

Заключение 

Разработанный алгоритм создания 3D-модели детали «корпус» оправдал себя на после-
дующих этапах работы с моделью. Упростилось создание 3D-модели воздушной полости для 
проведения газодинамического расчета за счет использования ассоциативных связей с моделью 
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детали «корпус». Быстро и успешно была выполнена модификация 3D-модели детали «корпус» 
при проектировании турбокомпрессора нового типоразмера. Это подтверждает правильность 
принятого метода создания 3D-моделей корпусных деталей в системе Pro/ENGINEER и позво-
ляет сделать следующие выводы: 

– система Pro/Engineer дает возможность гибко варьировать порядок компоновки формо-
образующих элементов в 3D-модели, но, тем не менее, на практике обычно принимается доста-
точно строгий порядок задания зависимостей между элементами, обусловленный логическими 
связями компонентов друг с другом;  

– алгоритм создания 3D-модели допускает возможность ее модификации; 
– в качестве базового тела как основы для дальнейшего моделирования следует прини-

мать элемент, который отражает наиболее общие черты формы моделируемого изделия, имеет 
наибольшее число связей с другими формообразующими элементами, будет минимально изме-
няться в процессе проектирования конструкции. 
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METHODS OF CREATION OF CAST DETAILS 3D-MODELS 
IN SYSTEM PRO/ENGINEER  

The technique and algorithm of cast details modelling in system Pro/Engineer is resulted. Rules 
of system tools use based upon the previous experience of working with system are given in detail. 
Verified algorithm for detail «Case» of turbocompressor designing is described. 




